
 

 

Easy CG 

User’s Manual 

 

 

 Current Software Version 

 /v 0.9.9 Build 095/ 

This manual explains in detail all functionalities of the  

Easy CG broadcasting solution. 

 

I 



Easy CG User’s Manual 

 

2 | P a g e  

 

Legal Notice 

 

The information in this manual is subject to constant change and it is for 

informational use only. 

No part of this document may be reproduced or transmitted in any form or 

by any means, electronic or mechanical, for any purpose without the express 

written permission of DEVTEK Bilisim Elektronik San Tic Ltd. 

The software described in this document is furnished under a license 

agreement. The software can be used or copied only in accordance with 

the terms and conditions of the agreements. 

DEVTEK Bilisim Elektronik San Tic Ltd. can introduce changes or improvements 

in the product described in this manual at any time and without any special 

notice. 

This publication may contain typographical errors or technical inaccuracies. 

While every precaution has been taken in the preparation of this document, 

DEVTEK Bilisim Elektronik San Tic Ltd. assumes no responsibility for errors or 

omissions. Nor is any liability assumed for damages, resulting from the use of 

the information, contained herein. Changes are periodically made to the 

information herein. They will be incorporated in new versions of the manual. 

Please, check our website regularly for User Manual updates. 

Please, address your comments or questions to: 

DEVTEK Bilisim Elektronik San Tic Ltd. 

Kaptanpaşa M Piyalepaşa B Famas Plaza 

B Blok K15 N105-108 Okmeydanı ISTANBUL 

Tel +90 212 582 2307 

Fax + 90 212 582 9395 

info@easymediasuite.com 

www.easymediasuite.com

mailto:info@easymediasuite.com
http://www.easymediasuite.com/
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Preface 

 

Dear customer, 

Thank you for purchasing our product! Easy CG can add graphics and 

multimedia to the input video signal in real-time, or to key and fill outputs, 

according to customer‟s choice. If there is a second monitor or video editing 

card in the system, it may be used as preview output. Infinite number of 

projects can be created as multiple layers. 

As always, we are trying to stay close to our customers‟ needs, making sure 

they all receive adequate support and satisfaction. Your opinion about our 

product is an exceptionally valuable source of information for us. The ease of 

working with our products results mainly from the suggestions and comments 

of our current respected customers.  

This manual is structured into several sequential chapters, each aiming to 

ease the installation, fine tuning, and use of our software. We hope that you 

will enjoy working with it, and we are anxiously looking forward to receiving 

your feedback.  

Please, send your questions, suggestions, and assistance requests to: 

support@easymediasuite.com 

General feedback: 

info@easymediasuite.com 

mailto:support@easymediasuite.com
mailto:info@easymediasuite.com
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Style Conventions 

 

 File names, software, documents or terms are written in italics  

 

Direct quotations from the computer screen are presented as follows: 

 Menu Items and commands 

 Tab/Page names 

 Field names, check boxes 

 Buttons 

 Screen readings are written in [square brackets] 

 The keyboard keys are enclosed in < > signs 

 

 The arrows, used in setting procedures mean as follows: 

  A menu item follows; 

  A page(tab) name follows; 

  A field name, a check box name or a value name 

follows. 

Except for arrows, you can distinguish between the relevant menu categories 

also by the stiles, listed above. 

 

A NOTE provides important information, recommendations, reminders and 

suggestions 

The CAUTION box indicates potentially dangerous operations. 
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Overview of Easy CG 

 

I. Introduction 

 

  Easy CG is a broadcast-quality live graphics solution, used for creating, 

displaying and control of various multimedia graphics. The graphical 

objects can be displayed in real-time over a live video in the 

workstation‟s input/output, or by output signal as Key and Field.  

 

 Easy CG can optionally show a preview via second hardware board 

output or on the workstation‟s monitor. 

 Easy CG supports unlimited layering and rendering of as many projects 

as required. Each project can contain multilayered objects. The studies 

can be saved as templates; arrangements on the templates can be 

made during the on-air session.  

 Easy CG allows controlling each project contained in the “publication” 

independently and without affecting other projects. In order to prevent 

an object replacement or moving by mistake, each object can be 

locked.  

 Assigning meta-tags is an easy way to find and play any of your 

projects in Easy CG. 
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 Easy CG supports common image formats, such as TGA, BMP, JPEG, 

GIF or PNG as graphics or sequences with or without alpha channel. 

 Timers, analogue and digital clocks can be inserted with different 

colours and fonts, allowing further customization by the user.   Easy CG 

can smoothly play multi-layer animations, prepared in sequential TGA, 

BMP, JPEG, GIF or PNG format with alpha channel. On top of that, 

basic geometric shapes (line, rectangle, circle, arc, polygon, etc.) can 

be created in “designer”. 

 Easy CG allows multilingual support via Unicode, including but not 

limited to Arabic, Russian, Chinese, Persian, Turkish and Cyrillic. 

 

 Multiple up/down, left/right, and vice versa scrolling text objects can 

be loaded simultaneously and they can run with different speed. 

Dynamic data coming from text, folder, RSS or XML file can be linked to 

any crawl or roll item and it can be updated on-screen in real-time. 

 

 Text objects can be marked as "fixed content" and "content that can 

be changed during the broadcast ". The colour and transparency are 

editable and customizable for the background, font, size, shadow 

settings, and so on. Logo and animation can be added to floating 

writings. 

 

 Easy CG has the ability to create graded background colours. 

Typefaces can be used oblique/italic, underlined, with shades, borders 

and so on. 

 

 Image sequence animation (image sequence) can be played without 

skipping. In Easy CG you can assign standard input/output effects and 

object duration to any of the projects. Objects can be linked to 

dynamic text data sources coming from text or XML files situated on 

the local computer or in any computer in the network. Each object is 

automatically updateable on-screen in real-time. 

 

 On top of that, Easy CG runs collective text files or image files; it comes 

with powerful RSS recording module allowing automated loading of 

broadcast RSS data feeds from the Internet with automated insertion 

of logos, images and animations. 

 

 Easy CG comes with features as sound support, allowing audio files 

insertion to an already prepared project. Easy CG provides a 
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searching engine: you can easily find your projects via keywords 

previously assigned to each project. 

 

 In addition, during on-air session, Easy CG can display a preview of 

another page without breaking the publication. 

 

 The Easy CG projects are exportable by third-party systems and 

transferable to KJ systems through the network or using an 

external/portable hard drive. 

 

 

 

II. Technical support 
 

General support is available from the Easy Media Suite web site by using the 

following URL:  

http://www.easymediasuite.com/. 

By clicking on TechSupport on the web site and open a ticket concerning the 

relevant problem. 

 

II.1. Phone support 

Easy Media Suite provides 24/7 phone support. 

 

II.2. On-site support 

Easy Media Suite provides on-site support as needed either during a project 

launch phase or in case the problem can‟t be resolved over the phone. 

 

II.3. Remote access 

Easy Media Suite provides remote support over Virtual Private Network for its 

customers. Upgrades, system configuration or log management may be 

handled via VPN. 

 

http://www.easymediasuite.com/
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Easy CG 

 

I. GETTING STARTED 
 

I.1. Quick Start 

 

 Verify all connections and start the workstation; 

 Launch the Easy Render Server; 

 Right-click the Easy Render Server‟s  button situated at the system‟s 

trey; 

 Define a video editing card to be used for the graphics. Then, choose 

a video standard for the project; 

 Launch the Easy CG module; 

 Go to the Objects menu, situated at the upper left-hand side of the 

main interface window ; 

 Select the desired object from the Objects menu. 

 Draw a rectangle in the Work area where you wish to place it.  

 

Well done! You have just created your first object! 
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II. USER INTERFACE 

The Easy CG module consists of two parts: Easy 

Render Server and Easy CG.  

The Easy Render Server is the graphics engine of Easy 

CG. It performs all commands that have been given 

via Easy CG Interface, in background. 

 

II.1. Easy Render Server 

Double-click the Easy Render Server icon, situated at 

your desktop. It will be added to the system tray. 

Right-clicking the  button will invoke a drop-down menu as the example to 

the right. The options of this menu are described as follows: 

 

II.1.1. Device 

Here you can see the currently selected 

hardware I/O module. If you would like to use 

another video editing card, you can select the 

desired one using this menu. 

 

II.1.2. Video Standard 

Here you can choose the input video standard. 

 

II.1.3. Blend mode 

This option concerns the blending process. It can be 

Internal (on the Easy CG workstation), External (using 

the relevant hardware I/O module), or OFF. 

 

II.1.4. Memory Cache 

It defines what part of the 

system memory to be specified 

for memory cache of the 

software.  

 

II.1.5. Purge Cache 

It purges the cache. This doesn‟t affect the on-going 

process. 
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II.1.6. Reset Engine 

This option resets the engine and cleans all channels that are sent to output. 

 

II.1.7. Registration 

For more detailed information, please refer to the License section further in 

this manual. 

 

II.1.8. About… 

Here you can find information about the current version of Easy Render 

Server. 

 

II.1.9. Shut down Server 

It shuts the server down and cleans all channels that are sent to the output.  
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II.2. Easy CG 

 

The Easy CG graphical user interface is divided to several areas:  

The topmost horizontal bar is Menu bar.  

To the left-hand side you can see an Objects menu and Pages pane.  

To the right-hand side, there is a Control menu.  

At the lower part of the screen, there are Adjustment settings which concern 

the already inserted objects. 

And, last, but not least – the Work area of Easy CG is situated at the centre of 

the interface. 

The Work area is where the production part is done. The number of objects in 

one Work area is unlimited. Also, the number of work areas (pages) in one 

project is unlimited. Moreover, you can run more than one instance of the 

Easy CG software.  

The number of Pages that can be sent to the output simultaneously is nine. Six 

of them can be designed to contain graphics. Three of them can be 

designed as logo layers. If a second page is sent to the output while 
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displaying one that already has graphics, the old graphics will be replaced 

by the new ones. If there is a page which is sent to the Easy Render Server via 

Easy CG interface, the interface can be closed without affecting the output. 

 

II.3. Objects menu 

The Objects menu is situated at the upper left-hand side of the main 

interface window. It contains buttons for all supported graphical objects: 

 

Line – draws a line. 

Box – select it to draw a square. 

Text – select it to type a fixed text. 

PText – select it to type a fixed text which acts as a 

paragraph. 

Circle – select it to draw a circle. 

Anim – select it to play animations. 

Crawl – select it to draw a text that flows horizontally. 

Roll – select it to type a text that flows vertically. 

Clock – inserts a digital clock object. 

A.Clock – inserts an analog clock object. 

Timer – inserts a timer object.  

Image – select it to insert an image file. 

Clip – select it to insert a video file. 

 

II.3.1. Line 

Choose the Line object to draw a straight line. In order to draw a line, click 

and hold the mouse left button on the Work area. Then, drag the mouse and 

release the button where the line is supposed to end. Well done! You have 

just created a line object with default settings. To edit the settings of the Line, 

go to the Work area and then left-click this object. 

 

The settings of the Line object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. These settings have 

similarities with other type of objects. 
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In the Position field, you can see the distances of the object to the Left and 

Top sides of the Work area. You can obtain width and height object-related 

information in pixels.  

In the Shadow field, you can define some shadow settings of the 

object. 

The option, set by default is None. For applying 

shadow to the object, press the None button to 

change it to Drop. 

 

You can set the shadow direction by choosing one of the 

eight circles which represent eight directions.   

 

 

 

 

 

 

The Outline field provides outline settings for the currently 

selected object.   

The value corresponding to Width represents the 

thickness of the outline. 

You can select a type of an outline from the Dash drop-

down list. 

You can choose whether the outline is going to be in 

front of the object or behind of it, by going to Pos, as in 

the example to the left. 

 

The field, located between the Outline 

and Tags fields is Color palette. It is 

provides color settings.  

 

A desired color can be achieved by 

typing values between 0 and 255 in 

the R, G, B boxes. You can set a 

transparency of the object by typing 

values between 0 and 255 in the A box 

which stands for “alpha channel”. 

 

A basic gradient operation can be done by clicking to the upper 

and lower side of the Solid button and assigning a desired color to its 

Top side and for its Bottom side. 

You can define two different colors and alpha values for each half 

of the object. 
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NOTE: The field between the Position and Shadow fields is designed for 

special settings related to each object.  

 

You can find more detailed information regarding the gradient settings in the 

Background chapter further in this manual. 

You can find more detailed information regarding the Image and Tags fields 

in the Box chapter.  

 

II.3.2. Box 

Choose the Box object if you would like to draw a square-shaped object. 

Then, draw a rectangle in the Work area to create it. A box with default 

settings is will appear.  To edit the settings of the Box, go to the Work area and 

then left-click this object. 

 

The settings of the Box object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. 

 

 

The Position, Shadow, Outline and Color Palette fields are the same as those 

of the Line object.  

In the Rectangle field you can specify 

what type of corners to be applied to 

the currently selected Box object. To 

do so, click the  button (“R” stands 

for “rounded”). The corners can be 

rounded, flat or chopped. If you 

would like to apply rounded corners to your object, 

fill-in the desired value within the active box corresponding to Corners in the 

Rectangle field. 

Press the Uniform button to deactivate it. This way, all corners of the Box 

object can be edited separately. 

 

There are four ways of adding a color or image to the Box 

object. To do so, click the Color button at the right side of 

the Color palette. You can choose between: Color, Image, 

Image Over and Image Under. When the Color option is 
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chosen, the Color palette stays active. The 

supported file extensions for inserting a picture are: 

*.PNG, *.TGA, *.JPG, *.BMP, *.GIF).   

To insert a picture, click the grey box situated 

under the Image button (it is shown in the example 

to the left). A dialog will appear for you to browse 

for the desired image. After choosing the image, 

press Open. The image will be loaded into the grey box. 

 

If you would like to add an image file in front of the color, defined in Color 

palette, choose the Image Over option from the drop-down list after clicking 

the Color button. 

 

In case you would like to add an image file behind the color defined in the 

Color palette, choose the Image Under option from the drop-down list after 

clicking the Color button. 

 

The Color palette and the Image can be seen by changing their alpha 

values.  

 

In order to facilitate and simplify the 

working process in Easy CG, all 

objects in the Work area can be 

tagged. This is in case you work with 

multiple objects. You can add a tag 

to an object just in few steps: 

 

 Choose the object in the Work area by left-clicking on it. 

 Type some text that defines the object itself to the text box in the Tags 

field. 

 Click the Add tag button to the right side of the Tags field. 

 Well done! This way you can choose any object by clicking its tag 

located in the Tags field. 

 

If you would like to see the tag notes in the Work area, press the Show tags 

button.  

 

NOTE: Deactivating the Show tags button, just removes the tags in the Work 

area. It doesn‟t deactivate the list of tags. 
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II.3.3. Text 

Choose the Text object if you would like to type a fixed text. Left-click on the 

Work area to insert the text object on the place it should begin.  

 

All settings of the Text object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. 

 

 
 

There are four options for selecting a text source and those are:  

 

 Local – to type the text directly into the Easy CG 

interface; 

 File – to link the object to a file with *.txt extension; 

 Folder – to link the object to a folder which contains 

several text files; 

 XML – to link the object to a file with *.XML extension.  

 

II.3.3.1. Local 

 

After choosing the Text object from 

the Objects menu, and clicking in 

the desired place into the Work 

area, a dialog window as the one to 

the left will appear.  

If you would like to select an option 

for text import, press the Local button 

(it is set as “Local” by default). 

The Edit dialog window consists of 

two tabs – Edit tab and Pictures tab. 

  

The Edit tab is designed for typing text.  

The Pictures tab is designed for applying inserting images or animation files 

into the text. The supported file formats are *.PNG, *.TGA, *.JPG, *.BMP, *.GIF, 

*.VXA). 
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In order to insert a 

picture, press the three 

dots situated to the 

right side of the 

Filename column. 

A standard browse 

dialog will appear. 

After choosing the 

appropriate file, press 

Open. The file paths of 

the images can be 

seen under the 

Filename column. 

 

 

There are two options provided by clicking the button under the Size column:  

Font to minimize the file to font height, and Image to insert the file with its 

original height.  

The Inserted file can be aligned to the Top, Bottom, and Center of the text. 

“Center” is set by default. It is important what is typed under the Separator 

column. The characters that have been typed here will be searched 

throughout the file and if the entire string is found, the file will replace the 

string. It is important not to choose characters that may be in file source.  

 

The  buttons located just under the Edit tab are designed for aligning 

the text to the left or to the right. The settings for type right-aligned languages 

can be specified here. 

 

II.3.3.2. File 

 

The text source can be changed by clicking on the Local button.  

Select the File option to link the object to a file with *.txt extension. A 

standard browse dialog will appear. After selecting the desired text source, 

press Open. 

 

NOTE: Any changes within the *.txt file while Easy CG is on air will be applied 

immediately to the text object. 

  

The rest of the settings for the File are the same as the Local ones.  
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II.3.3.3. Folder 

Select the Folder option if you would like to link the object to a folder which 

contains several text files. When the source is chosen as Folder, a standard 

browsing dialog opens up. The folder is chosen by selecting one of the text 

files contained in the folder.  

 

NOTE: All the text files inside the folder that contains a “chosen” text file will 

be defined as a source.  

The interval of changing between the text files is defined as seconds in 

Interval (s) box located in the Setup tab. 

  

II.3.3.4. XML 

 

For more detailed information concerning the XML files as a source, please 

refer to the Crawl chapter further in this manual. 

 

II.3.3.5. Object settings 

 

When you are ready with the source settings 

and you can see the text source in the Work 

area, press Ok. 

 

In comparison with the other objects, the 

difference here is related to the Text field, 

located between the Position and the Shadow 

fields. 

 

The default font can be edited by clicking on its name on the upper side of 

this field. 

Default font may be edited by clicking on its name on upper side of this field. 

The Arial font is set by default. Easy CG uses the fonts of the operating 

system.  
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NOTE: Any new fonts can be added to Easy CG by installing them in the 

operating system. 

The Height value represents the font size.  

The Width value is designed to enlarge or reduce the font size horizontally. 

The font can be slant between -45˚ and +45˚ by typing numbers between -45 

and +45 into the Slant. B makes the font bold. I makes the font italic.  

The Text field provides also aligning options such as: 

 Align text left,  Align text center,  Align text right. 

 

NOTE: You can right-click a text object in the Work area to convert it to crawl 

or roll object. 

 

II.3.4. Circle 

 

Choose the Circle object to draw a circle.  

Then, draw a rectangle in the Work area to create it. A circle with default 

settings is will appear. To edit the settings of the Circle, go to the Work area 

and then left-click this object. 

 

The settings of the Circle object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. 

 

 
 

The Position, Shadow, Outline, Color palette, the image adding option and 

Tags are the same as they are in the Box object.  

 

In comparison with the other objects, the difference here is related to the 

Circle field, located between the Position and the Shadow fields. It comes up 

with the following settings: 

 

 Full Angle – represents the total interior angle of the circle and its 

default value is 360°. It can be edited to ease calculations.  

 Angle Start – defines the beginning angle. 
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 Angle Size – defines the angle of pie of the circle with its ratio to 

defined angle in Full Angle, starting from the angle defined in Angle 

Start.  

 Convert to Multisegment, which is 

the second option in Ellipse Mode, 

transforms the object to 

multisegment. The circle can be 

sliced into pies and the basic 

settings of each pie can be edited 

separately by converting the object 

to multisegment. Those basic settings 

are provided after pressing Setup 

Segments button. After pressing the 

Setup Segments button, a 

configuration window as the one to 

the right will appear. 

To add a new segment, press the 

Add button. 

To delete a segment from the list, 

press the Del button. 

The Size parameter defines the width of a segment. 

The Shift% value defines the distance of the segment from the center 

of the circle and shifts the segment. 

The Cut value defines what part of the 

segment to be cut, starting from the center of 

the circle. 

Show shows the segment with the value of 1 

and hides it with the value of 0. 

 

II.3.5. PText 

 

Choose the PText object if you would like to type a paragraph text. Left-click 

on the Work area to the place the text object should begin.  

 

The settings of the Text object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. 

 



Easy CG User’s Manual 

 

24 | P a g e  

 

All features of the PText object are the same as the Text object ones, except 

the behaviour of the text as a whole paragraph, not as a line. The following 

text aligning options are provided for the paragraph text: 

 Align text left,  Align text center,  Align text right. 

II.3.6. Anim 

 

Select the Anim object if you would like to play an animation file. When you 

click in the Work area, a standard browsing window opens up. It will ask for a 

file with *.VXA extension. Detailed information about VXA file extension and 

how to create a file with *.VXA file extension, is mentioned in VXA Builder 

chapter further in this manual.  

After choosing the desired animation file, press Open. 

 

 

Settings for the Anim object are the same as the settings of the other objects. 

Exceptions the Animation field between the Position and the Shadow fields. 

The Anim object has three options which are:  

 Loop – it is inactive by default. Use it to make the object go into an 

infinite loop. 

 File – it shows the file path of the object. Use it to change the file or to 

link the original file again if the path of the file is changed.  

 Mark – use it to define a time interval of the animation. 

 

II.3.7. Crawl 

 

Select the Crawl object if you would like to display a text that flows 

horizontally. Left-click on the Work area to insert the crawl object on the 

place it should begin.  

 

The settings of the Crawl object are visible in the lower side of the Easy CG 

interface.  
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The window that pops up after clicking on the Work area is the same as the 

one of the Text object.  

You can choose an *.XML file as a text source and link it to the object in Easy 

CG. 

 

After choosing the desired file, created via the RSS Reader module, press 

Open. 

An XML Setup tab will appear. This tab is divided into two parts which are 

Source content and Output filter. The content of the XML file is displayed in 

the Source content section. Contents to be used from Source content are set 

in Output filter. The results of Output filter can be previewed in the Preview 

section located at the lower side of the window.  

 

Right-clicking to the Output 

filter section provides the 

following options: 

 

 Add text – adds a 

new text file. Double-click 

the text file in order to edit 

it.  

 Add newline – adds a 

new line. Double-click the 

line in order to edit it 

 Add Branch – 

contents inside of the sub 

branches in XML file as seen in tree structure on left side, are chosen in 

sub menu of Add Branch 

 Add this value – adds an output filter for the chosen branch and 

displays it in the output and preview parts of the screen.  

 Set Range – sets a range for the chosen branch, if the top branch has 

the chosen branch more than one. The range options may be set in 

sub menu of Set Range; are All branches to choose all branches that 

are the same with the chosen branch, First branch to choose only the 

first branch, and Branch range to set one or few branches.  

 

An image or animation file can be used as a separator while using XML 

as text source. Just define a separator for the file in the Pictures tab. 

Then, type that separator in the text file that has been added inside of 

the branch which its value added to output filter. The desired content 

can also be drag-n-dropped from the Source content to the Output 

filter. 
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The Position, Shadow, Outline, Color palette, image adding option and Tags; 

are the same as they are in Text object.  

 

The Text field between the Position and Shadow fields is partially the same as 

the one of the Text object. The features, that are specific to Crawl object; are 

Speed, Direction, Loop, and Ending behavior. 

 

 

II.3.8. Roll 

 

Select the Roll object if you would like to display a text that flows vertically. 

Left-click on the Work area to insert the roll object on the place it should 

begin. The window that pops up after clicking on the Work area is the same 

as the one of the Crawl object. 

 

The settings of the Roll object are visible in the lower side of the Easy CG 

interface. You can see them into the example below: 

 

 
 

There are two differences in settings of the Roll and Crawl objects. The first 

difference is in the alignment settings – such settings are not utilized by the 

Crawl object. The  second difference is in the direction setting that was „to 

right or left‟ in the Crawl object, is „to up or down‟ here. 

 

NOTE: Right-click the Crawl object situated at the Work area if you would like 

to convert it to a text or roll object. 
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II.3.9. Clock 

Press the Clock button if you would like to insert a digital clock that displays 

time and date information of the OS. Left-click on the Work area to insert the 

clock object on the place it should be positioned.  

The settings of the Clock object are visible in the lower side of the Easy CG 

interface. You can see them into the example below: 

 

 
 

The Clock field is located between the Text and the Shadow fields, in 

addition to settings provided by the Text field. The structure of the clock is set 

in Hours: Minutes: Seconds as default. The separator “ : ” can be edited by 

double clicking on it and typing any character that you would like to use for 

a separator. The right-click menu of any item on the Clock object, has three 

options which are: 

 

 Insert to insert a new item. 

 Change to change the item with another. 

 Delete to delete an item. 

 

You can add the following items: 

 

− Seperator;  

− Hours 00-23;  

− Hours 01-12;  

− Mins 00-59;  

− Secs 00-59;  

− Weekday short;  

− Weekday full;  

− Day 01-31;  

− Month 01-12;  

− Month short;  

− Month full;  

− Year 00-99;  

− Year full;  

− AM/PM switch;  

− Day of year;  

− Week of year 00-53  
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II.3.10. A.Clock 

Select the A.Clock object to create an analog clock that displays time and 

date information of the OS.  

 

Then, draw a rectangle in the Work area to create it. To edit the settings of 

the A.Clock, go to the Work area and then left-click this object. 

 

The settings of the A.Clock object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. 

 

The specific adjustment field now is the Analog Clock field. It is situated 

between the Position and the Shadow fields. There are three options in this 

field: 

 S to add an image for the seconds hand of the clock, 

  M to add an image for the minutes hand of the clock, and  

 H to add an image for the hours hand of the clock. 

 

II.3.11. Timer 

 

Select the Timer button if you would like to create a Timer object. 

Then, draw a rectangle in the Work area to create it. A timer with default 

settings is will appear. To edit the settings of the Timer, go to the Work area 

and then left-click this object. 

 

The settings of the Timer object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. 

In comparison with the other objects, the difference here is related to the 

Timer field, located between the Text and the Shadow fields. The only option 

on Timer, is structure of time display. 
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There is a Timer Control menu which appears under 

the PLAY button on right side of Work area.  

The Start and Pause buttons are used for starting or 

pausing the Timer object which currently runs on air. -

Dec sets the object as countdown timer, and +Inc sets 

the object as count up timer; in Direction under Timer 

Control menu. You can set an initial time by pressing 

the SET button. 

 

II.3.12. Image 

Select the Image object if you would like to insert an Image file. 

Then left click inside the Work area. A default browsing dialog opens up. After 

selecting the desired image, press Open. 

 

An image object with default settings is will appear. To edit the settings of the 

Image, go to the Work area and then left-click this object. 

 

The settings of the Image object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. 

 

 
 

In comparison with the other objects, the difference here is related to the 

Image field, located between the Position and the Shadow fields. This field 

provides the following settings: 

 

 File – use it to set a default source or to display an image file. 

 Folder – use it to display image files in a chosen folder with the duration 

that is editable to the Stay box. 

 

II.3.13. Clip 

Select the Clip object if you would like to insert a video file. 

Then left click inside the Work area. A default browsing dialog opens up. The 

supported file extensions are *.AVI, *.MPG, *.MPEG, *.M2P, *.MP4, *.MOV After 

the desired media file is selected, press Open. 

 

A video object with default settings is will appear. To edit the settings of the 
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Clip, go to the Work area and then left-click this object. 

 

The settings of the Clip object are visible in the lower side of the Easy CG 

interface. You can see them to the example below. 

 

 
 

In comparison with the other objects, the difference here is related to the 

Animation field, located between the Position and the Shadow fields. This 

field provides the following settings: 

 

 Loop – it is inactive by default. It makes the object to go into an infinite 

loop. 

 Scale – it equalizes the dimensions of the video file to object 

dimensions. 

 File – use this option to update the path of the source object, or to 

change it with another object. 

 

II.3.14. Background 

 

The Background of the Work area has its own settings, similar to the settings of 

the objects. The specific adjustment field for the Background is the Editor field. 

It is located between the Position and the Shadow fields. Click at a random 

place in the Work area to see the Background properties.  

The Editor field provides the following settings: 

 

 Video Safe Area is set to 10% as default.  

 Horz Center and Vert Center display 

horizontal and vertical lines which pass 

through the center of Work area. Those 

options work as reference lines. They are 

designed to help the user to determine 

placing results of the objects to the Work 
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area better.  

 

A basic gradient operation can be done by clicking to the upper 

and lower side of the Solid button and assigning a desired color to its 

Top side and for its Bottom side. 

You can define two different colors and alpha values for each half 

of the object. 

The default gradient value is set to 90°. If you would like to change this value, 

press the  button and then choose one of the following options: 

 

 

 0°: The color which is assigned to Top starts from the 

left side of the Work area. It gets mixed in the center of 

the Work area with the color which is defined to Bott. It 

starts from the right side of Work area.  

 45°: The color which is assigned to Top starts from the 

upper left corner of the Work area. It gets mixed in 

center of the Work area with the color which is assigned to Bott. It starts 

from the lower right corner of Work area.  

 90°: The color which is assigned to Top starts from the upper side of the 

Work area. It gets mixed in the center of the Work area with the color 

which is assigned to Bott. It starts from the lower side of Work area.  

 135°: The color which is assigned to Top starts from the upper right 

corner of the Work area. It gets mixed in the center of the Work area 

with the color which is defined to Bott.  It starts from the lower left 

corner of Work area.  

 Swap Colors: Swaps Top and Bott colors.  
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II.4. Work Area 

 

The Work area occupies the main part of the Easy CG graphical user 

interface. 

 

The Work area shows all graphical objects, previously placed into it, their 

positions, tag, type and so on. 

 

Each object can be moved throughout the Work area by using the drag-n-

drop method.  

 

Each object can be resized in the Work area. 

 

The position of each object can be turned to “fixed”. Just right-click the 

desired object and then choose Lock position. If you would like to “release” 

the object, right-click it again, then press Unlock position. 

 

To enlarge the Work area, go to the View menu  Zoom. 

 

To set the aspect ratio of the Work area, go to File menu  Preferences Set 

Work area. This configuration window is described in the File menu section 

further in the manual. 

 

II.5. The Pages pane 

 

Each project can contain one or many pages. A page is as a 

slide: it contains one or many graphical objects. 

 

The Pages pane is located at the left-hand side of the Work 

area. 

 

The currently selected page is marked in yellow frame as in the 

example to the left. 

 

To add a new page to the project, press the  Add button. 

To remove the currently selected page, press the  Remove 

button. Use the Set layout attributes  button to add a Name 

and Metadata for the currently selected page. When ready, 

press Ok. Once the page has a name, it can be searched by its‟ 

name in the Search field on the top of the Pages pane. 
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NOTE: Right-click on the Pages pane to edit the layout attributes of the 

currently selected page. Using the right-click menu, you can also add or 

remove pages. 

 

You can find more detailed information regarding the pages in the Page 

menu located at the Menu bar further in this manual. 

 

II.6. Control menu 

 

The Control menu is located at the right-hand side of 

the Work area. 

 

It provides options such as layer selection, input effects 

selection, direction, duration, size, sound file 

reproduction. 

 

The Work area allows you to design and create a 

specific layer which contains graphics. The Control 

menu allows you to send them to the output. 

 

To get several pages on the output just select them 

from the Pages pane and then assign one and the 

same layer to them. Select a layer from the Target 

plane, for example GRFX1. 

 

The Stop ALL button cleans the graphics layer. 
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II.7. Menu bar 

 

 

II.7.1. File menu 

The Fle menu contains all project-related 

commands. 

 

II.7.1.1. New 

This command opens a new blank 

project. 

 

II.7.1.2. Open 

Loads an existing project. 

 

II.7.1.3. Save 

This command saves the current project file. 

 

II.7.1.4. Save as 

This command saves the current project to a file with a *.vlb file extension. 

NOTE: If *.vly file extension is selected for saving the project, only the currently 

selected page from the Pages pane will be saved to be used in another Easy 

CG project or the Easy OnAir software. 

 

II.7.1.5. Layout 

This submenu provides the following options: 

 Export Layout – allows you to export the currently selected page from 

the Pages pane as a *.vly or *.vmy project file. Later on, you might 

want to use the page for a different project. 

 Import Layout – imports a previously saved page to the current project. 

 Export as bitmap - exports the currently selected page from the Pages 

pane as a bitmap image. 
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II.7.1.6. Preferences 

 

The aspect ratio of Work area should be the 

same as the aspect ratio of the output.  The 

aspect ratio of the Work area can be set by 

selecting one of the options provided in the 

configuration window or manually by 

choosing pressing the Custom button.  

 

Some of the defined aspect ratios may be chosen here, or it may be defined 

manually by choosing Custom. 

 

II.7.1.7. Exit 

This command exits the program. 

 

 

II.7.2. Edit menu 

 

This menu provides project-related options 

such as Undo, Redo, Copy and Paste. 

 

II.7.2.1. Undo (Ctrl+Z) 

This command undoes the last operation. 

 

II.7.2.2. Redo (Ctrl+Y) 

This command redoes the last operation. 

 

II.7.2.3. Copy (Ctrl+C) 

This command allows you to copy the currently selected object in the Work 

area. 

 

II.7.2.4. Paste (Ctrl+v) 

This command pastes the object that has been previously copied. 
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II.7.3. Selection menu 

 

This menu becomes active when you select an object from 

the Work area. Left click the desired object in order to 

select it. The Selection menu comes up with the following 

settings: 

 

 

II.7.3.1. Move up 

In case some objects in the Work area overlap, you can bring the currently 

selected object over another one. Just select the desired object and then go 

to the Selection menu  Move up. 

 

II.7.3.2. Move down 

To move the currently selected object under another one, go to the 

Selection menu  Move down. 

 

II.7.3.3. Bring to Front 

To move an object over all objects, select the desired object and then go to 

the Selection menu  Bring to front. 

 

II.7.3.4. Send to Back 

To move an object behind all objects, select the desired object and then go 

to the Selection menu  Send to back. 

 

II.7.3.5. Group 

This command is designed with a control facility in mind. It allows you to 

group several objects in the Work area. 

  

II.7.3.6. Ungroup 

Ungroup allows you to ungroup the already grouped objects. 
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II.7.4. Page menu 

This menu is related to the Pages pane 

which is located at the left-hand side of the 

Work area. This drop-down menu provides 

the following options: 

 

II.7.4.1. Next Page (Alt+PageDown) 

This command allows you to jump from the currently selected page in the 

Pages pane to the next page in the project list. 

 

II.7.4.2. Previous Page (Alt+PageUp) 

This command allows you to jump to the previous page in the Pages Pane. 

 

II.7.4.3. First Page (Alt+Home) 

Select it to jump to the first page in the Pages Pane. 

 

II.7.4.4. Last Page (Alt+End) 

Select it to jump on the last page of the project. 

 

II.7.4.5. Remove Empty Pages at End 

This command removes the blank pages at the end of the project list. 

 

 

II.7.5. View menu 

 

This drop-down menu contains the following 

options: 

 

II.7.5.1. Refresh 

This command will refresh the Work area. 

 

II.7.5.2. Zoom 

To enlarge the Work area, go to the View menu  Zoom. 

You can also use the Ctrl (-/+) keyboard combo to resize the Work area at 

your will. 
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II.7.6. Tools menu 

 

This menu contains two modules: VXA Builder and RSS 

Reader. 

 

II.7.6.1. VXA Builder 

Use this module to generate files with *.VXA extension.  Such files can be 

imported in the Animation objects. 

After selecting the VXA Builder from the Tools drop-down menu, a standard 

browsing dialog opens up. Now you can select the files you would like to use 

for creation of animation sequence. The supported file formats are *.PNG, 

*.TGA, *.JPG, *.BMP, *.GIF. Click any of the files, contained in the browsing 

folder. Then press Open. This action will select all the files contained in the 

folder. When all of the images are 100% selected, the animation sequence is 

ready to be saved. A new dialog box opens up. Press the Save button. 

 

II.7.6.2. RSS Reader 

 

Select the RSS Reader 

to assign RSS feeds to 

objects. 

Press the Add button to 

add a new RSS source 

to the left-hand side of 

the screen. There, you 

can see the Name of 

each separate source 

that is loaded into the 

RSS Reader module. It is 

displayed in the Name 

column. To change or 

remove an RSS source 

from the list, use the 

respective Chg and Del 

buttons. 

When an RSS source contained in the list is selected, the properties field 

located at the lower left-hand side of the RSS Reader configuration window 

becomes active. Press the Source button to modify the address corresponding 

to the RSS source. To change the RSS feed updating time interval, press the 
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button corresponding to Refresh. By default, the time interval for updating 

the feed is set to Every 1 sec.  

 

The RSS feed should be recorded into a file. To do so, follow the steps 

described to the example below: 

 

 Select the desired RSS source from the left-hand side of the RSS Reader 

configuration window. 

 Select the desired RSS feed from the right-hand side of the RSS Reader 

configuration window. 

 Press the No output button in the properties field located at the lower 

left-hand side of the RSS Reader configuration window to turn it to Single 

txt. 

 Press the Output button situated at the lower left-hand side of the RSS 

Reader configuration window. Then, select a folder in which to place 

recorded RSS feed. 

 

There are several options related to recording 

of RSS feeds. 

 

No output is set by default. 

Choose Single Txt to transfer the RSS feeds to a 

single text document. 

To transfer the RSS feeds to separate text 

documents, select the Multi Txt option. 

Select the XML File to transfer the feed to an 

XML file. 

 

 

 

 

 

II.7.7. Help menu 

Pressing the Help menu About will display 

useful information concerning the Easy CG 

software version. If you would like to visit our 

website, press the Go to web button. 
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II.7.8. Editor 

The Easy CG module operates in three modes: Editor, Playlist and Scheduler. 

 

II.7.9. Playlist 

This module is designed to control the pages. 

 

NOTE: Each page contains previously prepared graphics layout. Graphics 

layouts can be prepared in the Editor. 

 

You can see the page number to the left-hand side of the playlist grid (see 

the example below).  

To define a name of a page, go to the Pages pane, then right-click the 

desired page. A drop-down menu will appear. Select Set layout attributes. 

The Set layout attributes configuration dialog will appear. 

 

 
Now you can add a Name and Metadata for the currently selected page. 

When ready, press Ok. The names of all pages are displayed in the Name 

column of the Playlist module. 
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You can assign an input effect for each layout/page. 

Double-click the respective box in the Duration column to 

enter the desired time value for the input effect duration. 

Double-click the respective box in the Stay column to define 

how long the currently selected layout will be displayed on the 

output.  

You can specify graphics layer for each layout. 

To get several pages on the output just assign one and the same layer to 

them. 

 

 

II.7.10. Scheduler 

 

This module is designed for scheduling pages/layouts.  

The right-hand side of the grid contains all pages/ previously prepared 

layouts. Click the respective button, positioned next to each layout. The 

Schedule configuration dialog opens up. Select the day(s) and time for 

displaying the page. To activate the Scheduler, press the Active button. When 

you are done with the settings, press Ok. 
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II.8. Status bar 

The Status bar is located at the lowest part of the Easy CG graphical user 

interface. It contains information about the current time and date. It also 

contains information about the current software version of the module. 

 

 
 

Pressing the “Connected to Server” label on the Status bar 

allows you to see a list of each output that Easy CG may 

send commands to (see the example to the right). A project 

can be previewed while it is running on air without being 

interrupted. Just send it to another Easy Render Server 

instance. You can run more than one Easy Render Server 

instance. You just have to specify a Name and Hardware 

I/O Device for the desired instance. 
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III. License 
 

III.1. Demo version restrictions 

Even though the demo version of Easy CG doesn‟t have any restrictions on its 

interface, it adds a watermark to the output of your system. Once the 

activation process is done, the watermark will disappear. 

 

III.2. Activation 

 

You have to submit a license code and 

send it to us. To be able to see the license 

code, go to the Easy Render Server 

located at the system trey and press the 

 button. Then, select Registration. 

In the Registration window, enter the 

activation code that has been previously 

supplied by our company and click 

Register. 

Congratulations! After this process, the watermark will disappear from the 

output. 
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